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TOOL DEVELOPERS 

Leah Fine and Alexis N. Rife 

 

VERSION 

This tool is being released as a beta version that will be updated as we receive feedback from 

fishery practitioners. The beta designation is a recognition of the value of stakeholder input, 

which we know will make this tool even more successful in supporting sustainable fisheries 

management around the world. We invite you to share your feedback on the Sustainable 

Fisheries Toolkit website. 

 

TOOL COMPONENTS 

User guide 

Excel tool 

 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

Any views expressed in this tool and associated materials are those of the authors and do not 

necessarily represent those of the contributors or their organizations. Any errors are those of 

the authors. This tool and any supporting materials are decision-support tools and results 

should be interpreted as such. Neither EDF, nor the authors, take responsibility for any 

outcomes that result from the use of this tool. 

 

Copyright © 2018 Environmental Defense Fund. All rights reserved.  
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BACKGROUND 

 

Most fisheries have many activities that contribute to their functioning, including science, 

regulation, and enforcement; however, the groups or individuals responsible for carrying out 

these functions and the relationships between them may vary depending on local conditions. 

Identifying these stakeholders and their roles within a fishery system can provide context and 

inform strategies for implementing sustainable fisheries management. 

 

The Fishery Systems Mapping Tool helps define the functional roles of stakeholders in a fishery 

system, clarify the interactions between each group and compare their influence and interest in 

improving fisheries management. Use of this tool can help build knowledge of a fishery system 

and identify gaps in capacity, challenges, potential partners and strategic opportunities for 

improved fisheries management. 

 

Intended Audiences 

The Fishery Systems Mapping Tool is designed for use by fishery managers, non-governmental 

organizations (NGOs) and other practitioners to understand the landscape of a fishery system. 

The Tool can be completed through desk-based research rather than through field work, using 

white papers, scientific literature, internet searches and expert advice as references. 

Additionally, it can be used within a group setting to arrive at a common understanding of a 

fishery. 

 

When to Use This Tool 

The Fishery Systems Mapping Tool can be used at various scales and stages of the fisheries 

management process. The Tool can be used relatively early in the fishery reform process, to 

understand the stakeholders present in the system and gain insight and context that can inform 

strategic opportunities for fishery reform projects. For example, the Tool can help fishery 

practitioners collect information prior to beginning work in a fishery system, such as during the 

Strategic Scoping phase. However, the Tool can also be applied to smaller regions, individual 

fisheries or specific sites to better understand the dynamics within a fishery and it can be 

applied when interacting with fishery stakeholders, such as during the Assessment & 

Engagement phase. See the Sustainable Fisheries Toolkit website for more information on the 

phases of a fishery reform process. 

 

Limitations 

This systems map template is designed to be broadly applicable to a range of geographic 

locations, fishery types and governance scenarios, and to provide a consistent framework to 

guide identification of fisheries stakeholders and their roles within a system. However, there is a 

tradeoff between this consistency and the level of detail necessary to understand a given region. 

As mentioned previously, many parts of the system are not comprehensively represented by this 

tool, and will require further analysis for a specific site or fishery. In addition, the range of 

relationships between stakeholders and the processes that drive change in a system are not fully 

represented. 
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Given these limitations, this template should be used as one part of the larger diagnostics 

process, and additional tools should be used to map the supply chain, the regulatory process, the 

political economy and stakeholder interactions at the finer scale of a fishery or site. 

 

Finally, it will be challenging to identify all relevant stakeholders on an initial use of this 

template, especially in groups where many entities may be playing that role, like Conservation or 

Sellers. The map resulting from this process should not be considered static, and can be altered 

and added to as a better working knowledge of a country or region develops. 

 

INSTRUCTIONS 

 

Getting started 

This User Guide is designed to walk you through the Fishery Systems Mapping Tool, step-by-

step. The Tool is a Microsoft Excel workbook divided into multiple tables: (1) Overview, (2) 

Instructions, (3) Group Definitions, (4) Systems Map, (5) Power Map, (6) Relationships, and (7) 

Interpretation. You will fill out information in these tabs sequentially by completing the steps 

below. To begin, open the Fishery Systems Mapping Tool Excel file. 

 

Step 1: Define scope 

The first step is to clearly define the scope of the system you want to analyze. You may want to 

include all marine fisheries in a given country or large region, but if the country or region you 

are working in is particularly complex and heterogeneous (for example, the European Union or 

the United States), narrowing the scope of the analysis will be helpful. You may also choose an 

alternate entry point or method of defining the scope of analysis. For example, you might select 

only those fisheries managed by a certain regulatory agency, or only those that a specific group 

of fishermen target.  

 

You should also define the point in time you are analyzing, particularly if fisheries management 

in a country is changing quickly. It may be useful to update this analysis to understand how the 

system and stakeholder opinions change over time. 

 

Finally, you should clarify your goals for working in this system. For example, are you interested 

in understanding stakeholder attitudes towards a particular management option? These might 

include a form of secure fishing rights like IQs, ITQs, or TURFs, but may also include other goals 

like MPAs, improved catch monitoring, science-based management, etc. 

 

Once you have decided the scope of the system you want to analyze, click on the Group 

Definitions tab and enter the information in cell C3 (or click on the hyperlink provided on the 

Instructions tab). Example: Geographic location, fishery, point in time, management option(s) 

 

Step 2: Identify entities 

On the Group Definitions tab, the next step is to identify the “Entities or Institutions” that play a 

role in each functional group. To do this, read the Functional Group Definition (Column E) for 
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each Functional Group (Column D), for example Fisheries Resources. You can also find this 

information in the Group Definitions section of this User Guide.  

 

a. For each Functional Group, fill in the groups or stakeholders that play that role 

in the Entities and Institutions column (Column F). To help fill in the boxes, you 

may want to read reports, journal articles, online resources or consult with experts 

familiar with the region. Good places to start include FAO Fishery Country Profiles, 

OECD fisheries reports and MIT’s Observatory of Economic Complexity. If no 

stakeholders or groups fill a particular role, write “none.” It may be difficult to create an 

exhaustive list of all the stakeholders who fill these roles; if necessary, generalize or list 

the most important stakeholders.     

b. Add additional notes and considerations in the Notes column (in some cases, the 

Functional Group Defintions specify additional information it may be helpful to note).  

c. Include particularly helpful references in the Sources column (Column N).  

 

Once you have completed filling all the Entities and Institutions, and added any applicable 

Notes and Sources, proceed to Step 3. 

 

Step 3: Scoring 

In the Group Definitions tab, you can also assign a score for Adequacy, Influence and 

Interest/Alignment for each group and the Cohesion within that group. These scores 

are best determined by someone with a deep familiarity with the system, and an internal 

working group or discussion may be a good way to make sure the scores are representing the 

system well. However, they are still inherently subjective and may change over time. Review 

scoring for each category below: 

 

● Adequacy indicates the success of the entities within a given group in fulfilling that 

functional role—for example, how successfully the entities in the catch monitoring group 

are at gathering information about landings and discards. Adequacy scores are on a five-

point scale, ranging from low adequacy to high adequacy. Low scores indicate 

inadequacy/need for capacity building and high scores indicate that the entities in a 

group are successfully fulfilling that role. 

● Influence indicates the power and access that a given group has to create changes in 

fisheries management and regulations. Influence scores range from not influential to 

extremely influential, with higher scores indicating greater influence. Scores of very or 

extremely influential indicate that that stakeholder group has the potential to be a 

significant driving force behind changes in management, while scores of not or slightly 

influential indicate that they may not be able to incite change independently.  

● Interest/Alignment indicates how receptive to and engaged stakeholders are to secure 

fishing rights. Interest/Alignments scores range from strongly opposed to strongly 

supportive, If the group is evenly split on its alignment with secure fishing rights—for 

example, if half of industrial fishermen support secure fishing rights, but half oppose it—

assign a score of neutral and give that group a low score for cohesion. 

● Cohesion indicates the level of agreement within that group about their interest in 

secure fishing rights. Scores range from low to high cohesion, with a low score indicating 

http://www.fao.org/fishery/countryprofiles/search/en
http://www.oecd-ilibrary.org/trade/oecd-review-of-fisheries-policies-and-summary-statistics_22254323
http://atlas.media.mit.edu/
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low cohesion and a high degree of disagreement within the group, while a high score 

indicates that most entities in that group share a similar perspective. 

 

In all cases, it is more important to accurately represent the relative scores of each stakeholder 

compared to others in that region than the absolute scores. It may not be appropriate or possible 

to assign scores to each group (for example, it does not make sense to assign scores to the 

fishery resource or to laws and regulations). If that is the case, leave the scores blank. You 

should also leave the scores blank if no entities are listed for a particular group or if you have 

insufficient information to estimate a score. 

 

Step 4: System map 

Completing the Group Definitions worksheet (Steps 1-3) automatically populates the System 

Map with information you have entered about the fishery system. For example, as you fill in the 

Entities and Institutions column of the Group Definitions tab, the names of those entities and 

institutions will automatically be transferred to the System Map tab. This system map helps 

visualize the stakeholders within the system and the interactions between them.  

 

Some functional groups are clumped together in boxes—in particular, the supply chain, 

community, fishermen, and regulators. These boxes indicate that the groups within them have 

particularly close and complex relationships that may require further analysis during the 

Assessment and Engagement phase. 

 

The arrows define relationships between the groups. Some interactions are already defined by 

the arrows included in the map based on interactions typically observed in a fishery system. In 

the System Map black arrows indicate an exchange of information, green arrows 

indicate a financial transaction, blue arrows indicate resource use or impact, red 

arrows indicate a regulatory relationship and purple arrows indicate political 

influence. The bolder arrows indicate the relationships of particular importance that are 

examined in greater detail in the Relationships section (see Section G, below). Optionally, you 

may choose to modify these arrows in other ways to best represent the system you are mapping. 

Possibilities include: 

 

● You can add or remove arrows to this map (go to Insert→Shapes) to best represent the 

interactions between stakeholders present in this system.  

● The width of the arrows can also indicate the strength or effectiveness of the relationship 

between stakeholders. As a default, the arrows are set to a 4½ point width; these can be 

changed to 2¼ point to indicate a weak relationship or to 6 point to indicate a 

particularly strong relationship. For example, if fishermen communicate with regulators, 

but have very little influence over their decisionmaking, you might change the width of 

the black arrow between fishermen and regulators to 2¼. To change the width of the 

arrows, click on an arrow, then go to Format→Shape Outline→Weight. 

● The pattern of the arrows can also be changed to a dotted line to indicate notable 

conflicts between groups. To change the pattern of the arrows, click on an arrow, then go 

to Format→Shape Outline→Dashes. 

 



7 
 

To export the map as a PDF, go to File→Print and choose the PDF option as your printer. 

Change the page orientation to Landscape and select Fit Page on One Sheet, then hit Print. 

Printing on larger paper may be necessary to make the text large enough to read easily. 

 

Step 5: Power map 

When you fill in the Influence and Interest/Alignment scores on the Group Definitions tab, the 

functional groups will automatically appear on the plot in the Power Map tab. The four 

quadrants of this plot are labelled with potential approaches for engaging with stakeholders 

falling within that area: 

 

● Groups with both high influence and high interest in fisheries reform may be suitable 

potential partners in efforts to improve fisheries management. 

● Groups with high interest in fisheries reform but relatively low influence may be strong 

candidates for continued communication and/or capacity-building efforts, to 

strengthentheir continued participation and engagement with the process. 

● Groups with high influence but low alignment with fisheries reform goals should be 

engaged with and potentially motivated to support changes in management. 

● Groups with low alignment and low influence should be observed, but are not probable 

partners. 

 

Groups may fall on the vertical axis of the plot if they are indifferent to secure fishing 

rights, or if there is disagreement within the group. Groups on the vertical axis that have a low 

score for cohesion may require further analysis to determine which entities within that group 

may make good partners and which may require other approaches.  

 

If two groups appear in the same place on the grid, the data labels may overlap and be difficult 

to read; you can move the labels manually. Once you have manually adjusted any difficult to 

read labels, continue to Step 6.  

 

Step 6: Relationships 

The Relationships worksheet identifies 11 key relationships between functional groups. These 

relationships were identified through a review of the fisheries management literature and by 

drawing on experience implementing fisheries reform. They include interactions between: 

 

● Fishermen and Legislators/Regulators 

● Science and Regulators 

● Enforcement and Fishermen 

● Fishermen and Science 

● Lenders, Investors and Aid Providers and Science 

● Conservation and Fishermen 

● Community and Fishermen 

● Fishermen and other Fishermen 

● Fishermen and Fisher Organizations 

● Supply Chain and Fishermen 
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● Fishermen and Other Resource Users 

 

In the Relationships worksheet, each of these key relationships is separated into two 

directions—from the first party to the second party and vice versa. For each direction of each 

relationship, the user is asked to define: 

 

● The Nature of the Relationship—in particular, how cooperative or confrontational 

the relationship is. Options include Conflict, Some Animosity, Neutral, Cooperation, or 

Alliance. 

● The Effectiveness of the relationship. Effectiveness scores range from very ineffective 

to very effective. A relationship identified as particularly confrontational in the previous 

category is not necessarily effective; for example, there could be conflict between 

enforcement actors and fishermen, but the relationship could still result in effective 

enforcement of fishing regulations. Similarly, an alliance does not necessarily indicate 

that the relationship is fulfilling its functions effectively. 

 

Guiding questions are provided for each direction of each relationship to help the user evaluate 

these characteristics. The worksheet also indicates what is being transferred between the two 

parties in each case (information, political influence, regulatory authority, money, etc.). Please 

note that scores do not change any of the other sheet and this analysis is for a deeper analysis of 

these key relationships. 

 

The list of key relationships is not exhaustive, but represents those that are often critical to the 

success of fisheries management initiatives. If additional relationships are particularly 

important in the study area, the user can add and evaluate these relationships in the blank rows 

provided. 

 

Step 7: Interpretation 

This Tool serves as a good first step towards understanding how fisheries in a given country or 

region work, and will provide useful background and context moving into strategy development 

and site selection. The resulting system map can be used as a reference throughout the 

diagnostics process to highlight who plays certain roles within a system, the regulatory, financial 

and communications processes at work and the relationships between the various functional 

groups.   

 

This tool can also provide insight into three areas useful for strategy development. 

 

● First, it can help identify opportunities and potential partners for fishery 

improvement. Groups appearing in the upper right quadrant of the Power Map may be 

key stakeholders in the system and particularly good partners. For example, stakeholders 

in the Other Resource Beneficiaries and Support Service Providers groups benefit from 

healthy marine resources, and so may be interested in working towards sustainable 

fisheries management. Stakeholders in many of the community groups, including 

Influential Leaders and Conservation, and many of the fisher groups may also play a 

critical role. 
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● Second, it can point out potential challenges to improved fishery management. 

Excessive IUU fishing or Illicit Marine Activities may threaten the successful 

implementation of sustainable management practices. Groups in the upper left quadrant 

of the Power Map, potentially including political leadership or influential leaders that are 

not favorable to conservation or fisheries reform, may provide additional challenges.  

● Finally, the systems map can locate institutional gaps in the fishery system or 

marginalized stakeholders that may be a target for capacity building. For example, if 

the Stock Assessments or Enforcement categories indicate limited or no stakeholders 

engaged in these activities, building capacity in these areas may be a priority for the 

strategy in that country. Similarly, a lack of Financial Accountability or Lenders and 

Investors suggests an opportunity to improve fishermen’ access to capital. Groups 

appearing in the lower right quadrant of the Power Map are interested in supporting 

positive changes in fisheries management but have less influence in enacting those 

changes, so they may be good targets for developing opportunities to engage with the 

fisheries management process. 

 

As you are completing the template, record your observations and insights in these areas in the 

orange boxes in the Interpretation worksheet. Questions to guide interpretation of results are 

included in the worksheet. There is also an opportunity to note other insights or questions 

resulting from this analysis that may require a deeper dive. 

 

NEXT STEPS 

 

Additional systems mapping 

While this tool is designed to provide more information about the current state of a fishery, it 

may also be used to map out hypothetical management scenarios or an idealized version of what 

a system might look like if sustainable fisheries management can be successfully implemented. 

Comparing ideal and existing scenarios may help inform engagement strategies. 

 

This analysis may also be repeated or updated to understand how the system changes over time. 

The Alignment and Influence scores are likely to respond to engagement efforts, and the 

Adequacy scores and the roles of stakeholders within the system may shift as a result of capacity 

building and changes in management. 

 

Systems mapping may also be used as a method of stakeholder engagement. The results of this 

analysis can serve as a communications tool regarding the current state of the system.   

 

Capacity assessment 

This systems mapping exercise is a necessary first step in identifying system gaps and 

developing a plan to strengthen capacity within and throughout the system. Capacity 

strengthening, however, can and should happen at various levels: individual, organizational, 

network and system.  
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The individuals within a system, such as individual fishermen, policy makers, government 

officials, fishery management leaders and technical experts, may need additional tools and 

resources, knowledge and skills, or incentives and consequences to perform their roles more 

effectively in the system. 

 

The organizations within a given system, such as non-governmental organization (NGO) 

partners, fishery management organizations, scientific institutions and government institutions 

or ministries, may need organizational strengthening in areas such as financial management, 

service delivery, or administration to perform more effectively in the system. The systems map 

can help you identify priority organizations for further capacity analysis.  

 

Networks in the system, such as fishery associations or cooperatives, the seafood industry, 

associations of NGO partners, or business coalitions, can also represent opportunities for 

strengthened capacity by improving the flow of information and resources as well as increasing 

the collaboration, coordination and communication within networks.   

 

Finally, capacity should be assessed for the system itself, which in addition to individuals, 

organizations and networks, includes other factors such as the policy and legal framework, 

environmental factors, fisheries resources and the linkages between various components of the 

system. While this map begins to address these system-level capacity gaps, additional resources 

on the subject can complement this Tool.  

 

Other Sustainable Fisheries Toolkit resources 

Additional tools can also provide more detail about portions of the system at a finer scale. For 

example, the Fisheries Policy & Governance Analysis Tool can help diagnose the strength of 

fisheries policies and regulations.  For a complete list of tools that may help you conduct a more 

detailed analysis of elements of your fishery system, please visit the Sustainable Fisheries 

Toolkit website.  
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APPENDIX I: ADDITIONAL RESOURCES 

 

Relationships 

The Relationships tab of the Fishery Systems Mapping Tool examines critical flows (such as 

information, political influence, money and goods, etc.) between functional groups. Research for 

this tab came from peer-reviewed literature and EDF’s experiences with fishery reform. To 

explore more about these relationships, see the resources below. Note: if the relationship is 

examined in the Relationships tab, the row number of the Relationships tab has been indicated.  

 

FishermenRegulators (row 5) 

 Cinti, A., Shaw, W., Cudney-Bueno, R., & Rojo, M. (2010). The unintended consequences 

of formal fisheries policies: social disparities and resource overuse in a major fishing 

community in the Gulf of California, Mexico. Marine policy, 34(2), 328-339.  

 Ainsworth, C.H., Morzaria-Luna, H., Kaplan, I.C., Levin, P.S., Fulton, E.A., Cudney-

Bueno, R., et al. (2012). Effective ecosystem-based management must encourage 

regulatory compliance: A Gulf of California case study. Marine Policy, 36(6), pp.1275-

1283. 

 Cinti, A., Shaw, W. and Torre, J. (2010). Insights from the users to improve fisheries 

performance: fishermen’ knowledge and attitudes on fisheries policies in Bahía de Kino, 

Gulf of California, Mexico. Marine Policy 34(6), 1322-1334. 

 Jentoft, Svein, Thijs C. van Son and Maiken Bjørkan. (2007). Marine protected areas: a 

governance system analysis." Human Ecology 35(5), 611-622. 

 Bennett, E., Neiland, A., Anang, E., Bannerman, P., Rahman, A.A., Huq, S., et al. (2001). 

Towards a better understanding of conflict management in tropical fisheries: evidence 

from Ghana, Bangladesh and the Caribbean. Marine Policy, 25(5), pp.365-376. 
 

RegulatorsFishermen (row 5) 

 Ainsworth, C.H., Morzaria-Luna, H., Kaplan, I.C., Levin, P.S., Fulton, E.A., Cudney-

Bueno, R., et al. (2012). Effective ecosystem-based management must encourage 

regulatory compliance: A Gulf of California case study. Marine Policy, 36(6), pp.1275-

1283. 

 Cinti, A., Shaw, W. and Torre, J. (2010). Insights from the users to improve fisheries 

performance: fishermen’ knowledge and attitudes on fisheries policies in Bahía de Kino, 

Gulf of California, Mexico. Marine Policy 34(6), 1322-1334. 

 Jentoft, S., van Son, T. and Bjørkan, M. (2007). Marine protected areas: a governance 

system analysis. Human Ecology 35(5), 611-622. 

 Hernandez, A., and Kempton, W. (2003). Changes in fisheries management in Mexico: 

effects of increasing scientific input and public participation. Ocean & Coastal 

Management 46(6), 507-526. 
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ScienceRegulators/regulations (row 6) 

 Hernandez, Alvaro and Willett Kempton. (2003). Changes in fisheries management in 

Mexico: effects of increasing scientific input and public participation. Ocean & Coastal 

Management 46(6), 507-526. 

 

Enforcement Fishermen (row 7) 

 Cinti, A., Shaw, W., Cudney-Bueno, R., & Rojo, M. (2010). The unintended consequences 

of formal fisheries policies: social disparities and resource overuse in a major fishing 

community in the Gulf of California, Mexico. Marine policy, 34(2), 328-339.  

 Ainsworth, C.H., Morzaria-Luna, H., Kaplan, I.C., Levin, P.S., Fulton, E.A., Cudney-

Bueno, R., et al. (2012). Effective ecosystem-based management must encourage 

regulatory compliance: A Gulf of California case study. Marine Policy, 36(6), pp.1275-

1283. 

 Cinti, A., Shaw, W. and Torre, J. (2010). Insights from the users to improve fisheries 

performance: fishermen’ knowledge and attitudes on fisheries policies in Bahía de Kino, 

Gulf of California, Mexico. Marine Policy 34(6), 1322-1334. 

 Basurto, X. and Mateja Nenadovic. (2012). A systematic approach to studying fisheries 

governance. Global Policy 3(2), 222-230. 

 Hernandez, A. and Kempton, W. (2003). Changes in fisheries management in Mexico: 

effects of increasing scientific input and public participation. Ocean & Coastal 

Management 46(6), 507-526. 

 Bennett, E., Neiland, A., Anang, E., Bannerman, P., Rahman, A.A., Huq, S., et al. (2001). 

Towards a better understanding of conflict management in tropical fisheries: evidence 

from Ghana, Bangladesh and the Caribbean. Marine Policy, 25(5), pp.365-376. 
 

Intra-fisher relationships 

 Basurto, X. and Nenadovic, M. (2012). A systematic approach to studying fisheries 

governance. Global Policy 3(2), 222-230. 

 Bennett, E., Neiland, A., Anang, E., Bannerman, P., Rahman, A.A., Huq, S., et al. (2001). 

Towards a better understanding of conflict management in tropical fisheries: evidence 

from Ghana, Bangladesh and the Caribbean. Marine Policy, 25(5), pp.365-376. 
 

ScienceFishermen (row 8) 

 Cudney-Bueno, R., Bourillón, L., Sáenz-Arroyo, A., Torre-Cosío, J., Turk-Boyer, P., & 

Shaw, W. W. (2009). Governance and effects of marine reserves in the Gulf of California, 

Mexico. Ocean & Coastal Management, 52(3-4), 207-218.  

 Cudney-Bueno, R. and Basurto, X.. (2009). Lack of cross-scale linkages reduces 

robustness of community-based fisheries management. PloS one 4(7), e6253. 

 

FishermenScience (row 8) 

 Jentoft, S., van Son, T. and Bjørkan, M. (2007). Marine protected areas: a governance 

system analysis. Human Ecology 35(5), 611-622. 
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 Johnson, T. and van Densen, W. (2007). Benefits and organization of cooperative 

research for fisheries management. ICES Journal of Marine Science: Journal du 

Conseil 64(4), 834-840. 

 

Supply ChainFishermen (row 14) 

 Kaiser, Michel J. and Edwards-Jones, G. (2006). The role of ecolabeling in fisheries 

management and conservation. Conservation Biology 20(2), 392-398. 

 Charlotte, T. (2009). 10 Fisheries Supply Chain Issues for Developing Countries. From 

Hook to Plate: The State of Marine Fisheries, 129. 

 Bennett, E., Neiland, A., Anang, E., Bannerman, P., Rahman, A.A., Huq, S., et al. (2001). 

Towards a better understanding of conflict management in tropical fisheries: evidence 

from Ghana, Bangladesh and the Caribbean. Marine Policy, 25(5), pp.365-376. 
 

FishermenOther Resource Users (row 15) 

 Bennett, E., Neiland, A., Anang, E., Bannerman, P., Rahman, A.A., Huq, S., et al. (2001). 

Towards a better understanding of conflict management in tropical fisheries: evidence 

from Ghana, Bangladesh and the Caribbean. Marine Policy, 25(5), pp.365-376. 
 

Political Economy and Institutional Analysis 

Below are resources that you can use to assist with institutional analyses.  

 

 Fritz, V., Levy, B., and Ort, R.. (2014). Problem-Driven Political Economy Analysis: The 

World Bank’s Experience. Directions in Development. Washington, DC: World Bank. 

 Imperial, M. T. (1999). Institutional analysis and ecosystem-based management: the 

institutional analysis and development framework. Environmental management, 24(4), 

449-465. 

 Mcloughlin, C. (2014). Political Economy Analysis: Topic Guide (2nd Ed.) Birmingham, 

UK: GSDRC, University of Birmingham. Retrieved from: http://www.gsdrc.org/wp-

content/uploads/2015/07/PEA.pdf 

 Melim-McLeod, C. UNDP Institutional and Context Analysis Guidance Note. Retrieved 

from: http://www.undp.org/content/undp/en/home/librarypage/democratic-

governance/oslo_governance_centre/Institutional_and_Context_Analysis_Guidance_

Note.html 

 Poole, A. (2011). How-to notes: Political economy assessments at sector and project 

levels. Washington DC: The World Bank. Retrieved from: http://www. gsdrc. 

org/docs/open/PE1.pdf 

 Weible, C. M. (2007). An advocacy coalition framework approach to stakeholder 

analysis: Understanding the political context of California marine protected area 

policy. Journal of public administration research and theory, 17(1), 95-117. 

 UNDP‐UNEP Poverty Environmental Initiative. (2009). Draft Institutional Analysis 

Report for PEI Botswana. Retrieved from: 

https://www.unpei.org/sites/default/files/e_library_documents/botswana-

InstitutionalAnalysisReportPEI%20Botswana.pdf 
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APPENDIX II: GROUP DEFINITIONS 

 

A. Resources 

A.1 Fisheries Resources 

Living marine resources harvested by fishermen. Depending on the scale of analysis, these may 

be defined either as broad types of targeted resources or as specific species or species complexes. 

Examples: reef fish, groundfish, green urchin 

 

A.2 Habitats and Ecosystems 

The coastal and marine habitats and ecosystems that support healthy fisheries. Again, 

depending on the scale of analysis, these may be defined broadly or as specific habitat areas or 

types. 

Examples: mangroves, coral reefs, high seas 

 

A.3 Species of Concern 

Species other than those harvested by fishermen that are threatened by fisheries activities, a 

concern for fisheries managers, or of particular ecological importance to fished species. This 

may include species that were once fished but can no longer be landed due to their poor 

biological condition. 

Examples: vaquita, loggerhead sea turtles, forage fish, Atlantic salmon 

 

B. Fishermen 

B.1 Small-Scale Fishermen 

Fishermen using relatively small vessels and gear, and sometimes fishing nearer to shore on 

shorter trips or with lower levels of technology and investment.  

Examples: New England’s small dayboat fishermen; Belizean finfish fishermen 

 

B.2 Industrial Fishermen 

Fishermen using relatively large vessels and gear. They often take longer fishing trips farther 

from shore and catch more fish on a single trip when compared to small-scale fishermen, fish 

with higher tech gear and greater levels of investment, and may be associated with commercial 

companies. 

Examples: large Alaskan pollock trawlers, South African deep-sea hake trawlers 

 

B.3 Subsistence Fishermen 

Fishermen whose catch is primarily consumed by the fishermen themselves and their families. 

Generally, subsistence fishermen fish near to shore with relatively low tech fishing methods. 

Subsistence fishermen often depend on fish as an important source of food, and may sell small 

amounts of their catch as a source of income. 

Examples: Alaskan subsistence fishermen, Filipino coastal subsistence fishermen  
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B.4 Indigenous Fishermen 

Fishermen belonging to ethnic groups native to the region. It is helpful to note whether or not 

indigenous fishermen are subject to a different set of fishing regulations than other fishermen, 

depending on the existence of reserved indigenous fishing rights or treaties. 

Examples: Australian aboriginal fishermen, Pacific Northwest tribal fishermen 

 

B.5 Recreational Fishermen 

Fishermen who catch fish for sport and personal use, rather than sale or subsistence. 

Examples: Gulf of Mexico recreational red snapper fishermen, Cuban recreational 

billfishermen  

 

B.6 IUU Fishermen 

Fishermen violating laws and regulations, not reporting their fishing activities or catch to the 

appropriate authorities, or fishing outside of regulatory oversight by fishing without nationality 

or in unregulated areas. 

Examples: Chilean loco fishermen outside TURF areas; foreign fishermen in Indonesia’s EEZ 

 

B.7 Fishing Organizations 

Any organizations composed mostly of fishermen that participate in fisheries regulation and 

harvest and represent fishermen’s interests, including sectors, cooperatives, associations, and 

other groups. These organizations may be the entities to which regulations apply—for example, 

territorial use rights may be granted to a cooperative rather than to individual fishermen—or 

they may participate in fishery management less directly. 

Examples: New England groundfish sectors, Mexico’s fishermen’s cooperatives 

 

C. Other Marine Resource Users 

C.1 Other Resource Beneficiaries 

Groups, individuals, or industries other than fishermen who interact with the fishery resource 

and marine ecosystems and benefit from the health and stability of these resources. Often, these 

groups will use the resource in a non-extractive manner, but some extractive uses - like certain 

types of aquaculture that are dependent on a healthy ecosystem - may also fall into this category. 

It is helpful to note which type of resource use is occurring. 

Examples: scuba divers, tourist industry 

 

C.2 Other Resource Impacters 

Groups, individuals, or industries whose actions affect the fishery resource, but do not benefit 

directly from its health and stability. Often, these groups will be engaged in activities that can 

cause direct harm to fish or indirect harm to fish stocks through habitat loss or alteration. These 

activities may include both extractive uses of marine environments like mining and non-

extractive uses like shipping, as well as onshore activities like agriculture that affect coastal 

environments.  

Examples: oil drilling operations, shrimp aquaculture in mangroves 

 

C.3 Illicit Marine Activities 
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Illegal uses of the marine ecosystem other than IUU fishing, which may have an impact on 

fishermen or management.  

Examples: coyotes, drug smuggling, human trafficking 

 

C.4 Environmental Threats 

Environmental factors or changes that influence the health of fish populations. While these 

threats may be directly caused by humans, the causes are outside the analyzed system or 

indirect enough that they will likely not be a primary focus of fisheries reform.  

Examples: climate change, excessive predation, ocean acidification 

 

D. Legislators and Regulators 

D.1 Political Leadership 

The decision-makers with oversight of the system as a whole and the authority to develop 

policies about how resources are managed on a large scale. If working on a national scale, this 

will likely be the head of state. 

Examples: Obama administration; presidents of the European Union institutions 

 

D.2 Legislators 

Those who make laws guiding how fisheries are managed, but are not responsible for developing 

or enforcing the regulations to implement these laws. This category may include international, 

national, and/or smaller-scale lawmaking bodies, depending on the scale and context of the 

observed system. 

Examples: Myanmar Assembly of the Union; Massachusetts legislature; United Nations 

Conference on the Law of the Sea 

 

D.3 International Regulators 

Those who write rules and regulations regarding how fishing is conducted at an international 

level; for example, Regional Fishery Management Organizations and various United Nations 

agencies.  

Examples: International Commission for the Conservation of Atlantic Tunas, Canada–USA 

Steering Committee, United Nations Food and Agriculture Organization 

 

D.4 National Regulators 

Those who write rules and regulations regarding how fishing is conducted at the national level. 

Generally, this will include government agencies. 

Examples: National Oceanic and Atmospheric Administration, Cuba’s Ministerio de la 

Industria Alimentaria 

 

D.5 Regional/Local Regulators 

Those who write rules and regulations regarding how fishing is conducted at the local or 

regional level, or for a specific fishery. May include government agencies, fishing organizations, 

or other groups involved in co-management. Third-party sustainability certifications may play a 

de facto regulatory role in certified fisheries by requiring that certain standards be met to ensure 

certification. In some cases, community groups or the general public may also serve local 

regulators through social expectations. 



17 
 

Examples (high governance): South Atlantic Fishery Management Council, TURF 

cooperatives, Belize Fisheries Department 

Examples (low governance): community members or organizations 

 

E. Legislation and Regulation 

E.1 Laws and Policies 

The large-scale principles and national, international, or regional statutes that guide how 

resources are managed and how regulations to implement these management practices are 

developed and enforced. Policies may be formal, written plans or the informal objectives of 

political leadership. 

Examples: NMFS Ecosystem-Based Fishery Management Policy, EU Common Fisheries Policy, 

Myanmar Fisheries Law 

 

E.2 Regulations 

The rules and mechanisms that implement laws, policies, and societal expectations regarding 

resource management at international, national, or local scales. These may be formal rules or 

societal expectations. Define regulations at a broad level -  you should note if there are fishery 

management plans, no-take zones, catch limits, permit requirements, or input controls, but do 

not need to comprehensively list the specific rules (gear restrictions, number of days at sea, etc.). 

Examples (high governance): Fishery Management Plans, TACs, marine protected areas, 

limited entry permits, input controls 

Examples (low governance): social pressure to fish in specific areas, taboos 

 

F. Finance 

F.1 Lenders and Investors 

Groups, organizations, or individuals that provide loans or other forms of capital and 

investment to fishermen or other components of the fishery system and expect to receive a 

return on their investment. May include NGOs, international organizations, investors, banks, 

processors, or other components of the supply chain. It is helpful to note if lending practices are 

predatory or cause excessive burdens on fishermen. 

Examples (high governance): California Fisheries Fund, government loan funds, bank loans 

Examples (low governance): loan agreements with processors 

 

F.2 Aid Providers 

Groups, organizations, or individuals that provide grants or aid to fishermen or other 

components of the fishery system, including monitoring and research efforts. Often, this aid 

may need to be used for specific projects and may come with requirements for specific 

management methods, conservation practices, research, reporting and accountability, or other 

activities. However, grants and aid do not need to be paid back, and aid providers do not expect 

any direct financial returns. 

Examples: USAID, federal disaster funding, philanthropic organizations 
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F.3 Financial Accountability 

External parties who audit the operational and financial actions of fishermen and fishing 

organizations and enforce appropriate behavior to ensure compliance with regulations, protect 

against fraud, and increase confidence for granters and investors. 

Examples: IRS, private auditors, government auditors, local law enforcement 

 

G. Community 

G.1 Education and Communication 

Those who communicate regulations, community actions, and conservation efforts to fishermen 

and fishing organizations to promote compliance with regulations and encourage best practices, 

and who facilitate communication between fishermen, other stakeholders, and regulators. 

Successful education and communication may play a large role in resolving conflicts between 

fisher groups and between regulators and fishermen. 

Examples: industry or community leaders, government officials, NGOs, media 

 

G.2 Influential Change Agents 

Influencers within the community who play a role in organizing community members, fostering 

conversations and participation in management, and guiding public opinion. Organizations that 

advocate for the interests of the fishing industry but that do not directly participate in fisheries 

harvest or regulation may be included here. For the most part, these will be groups, although 

some particularly important individuals may also be included; influential individuals can be 

more comprehensively identified at the site level.  

Examples: fishing industry leaders, journalists, religious leaders, local politicians, unions 

 

G.3 Community Development  

Groups, agencies, institutions, or individuals who support the development of collective 

community action to reach common goals and services that benefit the community as a whole. 

Limit this category to groups that have some connection to fishing or fisher communities, or 

that could potentially help address a gap in capacity (for example, groups that could help build 

financial literacy among fishermen). 

Examples: community development corporations, NGOs 

 

G.4 Conservation 

Groups, agencies, institutions, or individuals who encourage conservation and sustainability in 

the use of fisheries resources by communication with fishermen, fisher organizations, 

regulators, political leaders, and/or components of the supply chain. Note if there are large 

differences in philosophy or approach between different conservation organizations. 

Examples: EDF, sustainability certifications, international/local NGOs, community members 

 

G.5 Support Service Providers 

Groups, individuals, or industries providing services to fishermen. These providers receive 

financial benefit from the fishing industry, but not directly from the sale of fish (in other words, 

they are not part of the seafood supply chain).  

Examples: ice companies, bait shops, gear manufacturers, mechanics, port managers 
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H. Supply Chain 

H.1 Seafood Inspection and Quality Control 

Organizations or agencies who inspect the quality of seafood.  Inspections may be conducted to 

ensure food safety, protect against seafood fraud, comply with regulations, and provide access to 

export markets. 

Examples: US FDA, Canadian Food Inspection Agency 

 

H.2 Marketing 

Organizations, certifications, or individuals who market seafood to domestic or international 

buyers and consumers, emphasizing its quality, sustainability, or other characteristics to 

increase the price received by one or more components of the supply chain. 

Examples: state or regional seafood marketing associations, Marine Stewardship Council, 

Fair Trade, Gulf Wild, Maine Lobster Marketing Collaborative 

 

H.3 Primary Buyers, Processors, and Exporters 

Those who initially purchase seafood from fishermen, process seafood into value-added 

products, and/or export seafood to foreign markets. Generally, though not always, this will take 

place in the country where the fish is landed. If possible, note if prices offered to fishermen are 

competitive or fixed, and if fishermen have exclusive relationships with any buyers or 

companies. 

Examples: individually owned trucks that sell to processors, local processing plants, StarKist 

in American Samoa 

 

H.4 Importers, Wholesalers, and Distributors 

Those who import, sell, and/or distribute bulk quantities of seafood to retailers and vendors. 

Secondary processing may be conducted by some entities in this category. 

Examples: US Foods, Trident, Fulton Fish Market 

 

H.5 Retailers and Vendors 

This category includes grocery stores, restaurants, and institutional dining. Those in this group 

sell directly to consumers, but some may be vertically integrated and operate their own 

processing and distribution networks. 

Examples: Whole Foods, Kroger, Red Lobster      

 

H.6 Consumers 

The end consumers of seafood products, whether local, domestic, or international. 

Examples: tourists, local coastal residents, EU consumers, used as bait 

 

I. Monitoring and Enforcement 

I.1 Catch Monitoring 

Those who measure and monitor fisheries catch on an ongoing basis. Monitoring may be 

conducted by the fishermen themselves or an external group like at-sea or dockside monitors. Is 

possible, note whether monitoring includes the collection of biological information like the sex, 
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length, and age of the catch and whether it accounts for discards. 

Examples (high governance): North Pacific Observer Program; electronic monitoring 

Examples (low governance): self-reported catch measurements by fishermen, market/auction 

records 

 

I.2 Enforcement 

Those responsible for ensuring that fishermen cooperate with international, national, and 

regional laws and regulations. In some cases, this category may include government 

enforcement agencies like a Coast Guard; in the absence of formal enforcement capacity, it may 

include informal mechanisms like community or individual actions. 

Examples (high governance): NOAA Office of Law Enforcement, Philippines Fishery Law 

Enforcement Officers 

Examples (low governance): social disapproval, community group sanctions 

 

J. Science 

J.1 Stock Assessments 

Groups, agencies, institutions, or individuals who carry out stock assessments to determine the 

status of fisheries resources and guide regulatory actions. Stock assessments may have varying 

levels of formality, scientific guidance, and peer review.  

Examples (high governance): European Commission Scientific, Technical and Economic 

Committee for Fisheries, NOAA Fisheries Science Centers, consultants 

Examples (low governance): FIHSE assessments conducted by fishery managers or fishermen, 

local ecological knowledge 

 

J.2 Social Science 

Groups, agencies, institutions, or individuals who carry out social science research related to 

fisheries and fishing communities, including economics, sociology, and political science. 

Examples (high governance): NEFSC Social Sciences Branch, academic 

institutions/universities 

Examples (low governance): fisher organizations, community groups 

 

J.3 Fisheries Data Collection 

Groups, agencies, institutions, or individuals who gather data about the status of fisheries 

resources. This may include both fisheries-dependent (catch, CPUE) and fisheries-independent 

(survey) data. 

Examples (high governance): National Marine Fisheries Service, academic 

institutions/universities 

Examples (low governance): fisher organizations 

 

J.4 Ecosystem Research 

Groups, agencies, institutions, or individuals who carry out research on the functions and status 

of marine habitats and ecosystems to help understand the status of fisheries resources and guide 

regulatory actions. This research may help identify important habitat areas, understand marine 

food webs, define fish life cycles, etc. 
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Examples (high governance): NOAA Fisheries Science Centers, universities and other research 

institutions 

Examples (low governance): fishermen, local ecological knowledge, universities and other 

research institutions 

 

J.5 Fishing R&D 

Groups, agencies, institutions, or individuals who fund and/or carry out research on new fishing 

gears or technologies and support innovation in fishing practices. 

Examples: Australia’s Fisheries Research and Development Corporation, fishermen and fisher 

organizations, universities and other research institutions, NFWF Fisheries Innovation Fund 

 

K. Judicial Process 

K.1 Judiciary 

Judicial processes, mechanisms, or procedures encompass the enforcement of regulations and 

laws, the prosecution of violators and the systems available for users and stakeholders to take 

legal recourse to ensure authorities are fulfilling their responsibilities. Examples: US Supreme 

Court, European Court of Justice, civil and criminal courts 

 


